
During 1999, Microsoft under-
took a lengthy consultation
exercise among subscribers to

its monthly Technet CDs. Among
other things, the company asked for
suggestions for improving the product
and making it easier to use. From the
feedback it obtained, Microsoft de-
cided to develop a substantially en-
hanced version of INFOVIEW.EXE,
the viewer program used to browse,
search, bookmark and annotate the
Technet content.

Given the importance of Technet to
support staff, it is worth taking a closer
look at this upgrade. This article is
based on the beta version which Mi-
crosoft issued in November 1999, but
the final release should be available by
the time you read this. You may find
that a few of the details I will describe
are different in the final release.

If you do not yet subscribe to Tech-
net you should definitely consider do-
ing so. Essentially, it is a bundle of
CD-ROMs containing extensive tech-
nical information on Microsoft prod-
ucts and technologies. It includes
product specs, review guides, user
manuals and resource kits, plus the

full Microsoft Knowledge Base.
As well as documents, it also con-

tains software, including service
packs, drivers, add-on programs, utili-
ties and evaluation products. There are
now around three dozen CDs in the
bundle, many of which are updated
every month. (For a full description of
the product, see “Getting The Most
From Microsoft Technet”, PCSA Update
123, January 1999.)

The Search Window
One of the most important innova-

tions in the viewer program is the sim-
plified search window (Figure 1). To
use it, you simply enter a search term,
choose between “All Text” and “Title
Only”, and optionally select a filter.
The various scope options from the
previous version (Current Topic Only,
Last Topic Found etc) are no longer
present, although their functions are
available in other ways. The search
syntax is exactly the same as before, so
you won’t need to learn any new rules.

To open the search window, either
select Tools/Search, hit the Search but-
ton on the main toolbar or press Ctrl-S

(not Ctrl-F as in the previous version -
this now opens the Find dialog, which
is described later). For most searches
this simplified window will be all you
need. However, pressing the Ad-
vanced button reveals some further
options (Figure 2).

The Exclude Topics Containing
control lets you specify a list of words
or phrases which you want the target
documents not to contain. This is simi-
lar to the boolean NOT operator, ex-
cept that it is persistent: what you enter
here will be retained for future
searches, even across sessions, until
you explicitly delete it.

The Filter By Date option is a much-
requested feature. All Technet docu-
ments are date-stamped, and this
option lets you include the date in your
searches. You can only select dates to
the nearest three months, but this
should be adequate in most cases. The
date does not necessarily appear in the
document text, but it is visible in the
search results window.

The “Find alternative word forms”
checkbox lets you decide if stemming
should be enabled. If it is, the program
will search on different forms of the
words in your search terms - for exam-
ple, if you search on print, it will also
find printer and printing. In the pre-
vious version, stemming was always
enabled.

The “NEAR means within” option
allows you to specify how the NEAR
operator is interpreted. By default, X
NEAR Y means that X must be within
eight words of Y, but this option lets
you vary that figure. In the previous
version, this setting was in the Options
dialog.
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There is also a “Maximum hits to
return” option. You used to get a maxi-
mum of 200 hits. You can now adjust
that figure to anything between one
and 2,000. If the number that you spec-
ify is less than the number of hits actu-
ally present, the least relevant ones
will be discarded.

The Defaults button puts all the ad-
vanced options back to their default
settings. In fact, this only works if you
actually run a search. There is no way
of restoring the defaults, or changing
the settings in any other way, without
starting a search. (This issue came to
light during beta testing and might be
altered in the final release.)

Search Results
After you run a search, the results

will be displayed in a window like the
one in Figure 3. This window is dock-
able: if you drag it towards the edge of
the screen, it docks itself at that edge.
To undock it, you press what looks like
the Minimise button (but which is not
necessarily in that button’s usual posi-
tion).

Like in the previous version, the
results window is modeless, so you
don’t have to close it in order to scroll
the current document. Unlike in the
previous version, there is no option to
automatically close the window when
you select a document from it.

Certain aspects of the search results
window were criticised by beta testers.
The main problem is that it is too easy
to dock it accidentally: a slight move-
ment towards the edge of the screen is

all that’s needed. Also, it takes up
much too much space when docked.
Another issue is that the method of
undocking is not as intuitive as it could
be. You expect to be able to undock it
by dragging it back towards the mid-
dle of the screen, but this only makes
it larger. Microsoft might change these
details in the final release.

As well as the date-stamp men-
tioned earlier, the results window now
displays a paper-clip icon to indicate
documents which include links to files.
These are in addition to the usual Or-
der, Book and Topic columns. All these
columns can be resized and re-posi-
tioned by dragging with the mouse.

Deleting Hits
It is now possible to remove indi-

vidual documents from the search re-
sults window. This could be useful if
you want to simplify the hit list. For
example, you could sort the results by
book, then multi-select the books you
are not interested in and delete them.
Deleting items in this way also affects
the search history and the “Create fil-
ter with these results” option (both de-
scribed later). To delete hits, simply
select them, right-click and select De-
lete Row(s).

Find In Topic
One of the features most requested

by Technet users was the ability to
search the current document. In the
previous version, you could do this
with the Current Topic Only scope op-

tion, but that meant starting a new
search and losing the current hits.
Now, you can use the Find dialog to
search the current document inde-
pendently of the main search. This
works just like the Find option in
Word, Excel etc. To invoke it, choose
Edit/Find in Topic or press Ctrl-F.

Filters
If you are a regular Technet user,

you will know that one of the best
ways of refining a search is to select a
filter - what used to be called a subset.
Technet comes with several pre-de-
fined filters; you can also define your
own.

For example, if your main interest
is in evaluating new products, you
might use the built-in Evaluation And
Reviewer’s Guide filter. If your job is
to support Word and PowerPoint, you
might create a filter based on those two
products.

None of this has changed in the new
version (except that there are now only
eight built-in filters rather than 12 as
before). However, the program now
offers several faster ways of creating
filters.

One possibility is to create a filter
based on particular books or docu-
ments within the Contents pane. To
achieve this, select the items in ques-
tion (use the Shift or Ctrl keys to multi-
select), then right-click and select
Search. This will bring up the standard
search window, with all the options
intact, but with the filter set to Quick
Search Filter. This filter contains ex-
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actly the items you selected. You can
now go ahead and run the search.

Normally, this filter is not retained
after the search finishes. But, if you
click on Define Filter within the search
window, you will be able to save the
Quick Search Filter under a new name.
Alternatively, from the context menu,
select Create Filter rather than Search.
This will take you straight to the De-
fine Filter dialog, with the filter al-
ready set up, ready for you to rename
and save it. In this case, the filter’s
default name is Quick Custom Filter.

Another option is to create a filter
based on the current hits. To do so,
click on the “Create filter with these
results” button at the top of the search
results window. Or, select some or all
of the documents in the results win-
dow, right-click and select Create Fil-
ter.

Either way, you will reach the De-
fine Filter dialog, with the specified
filter ready to save. (Any items which
you have manually deleted from the
results window will be excluded from
this filter.) These features are similar to
the old Previous Search Results scope
option.

Contents Filtering
As well as using filters with

searches, it is now possible to apply
them to the Contents pane; in fact, this
was possible in the previous version,

using the Contents/Select Subset com-
mand, but it is now easier and more
obvious. All you have to do is select the
required filter from a drop-down list
which appears at the top of the pane.

As an added convenience, if you
apply a filter to the Contents pane and
then start a search, the same filter will
be selected in the search window. Both
settings are retained across sessions, so
if you are only interested in a subset of
the Technet content, you can set the
filter in this way on a semi-permanent
basis and never have to see anything
else.

Search History
As in the previous version, the pro-

gram keeps a record of your last 20
search terms. To run a search again,
you can select the relevant term from
a drop-down list, optionally edit it,
then proceed with the search in the
normal way. As before, only the search
terms themselves are saved, not the
associated filters or options.

In addition, the program now stores
a record of all the search results in the
current session. You can navigate
backwards and forwards through
these results without having to re-run
the searches. To do so, click on the
“Back in search results” and “Forward
in search results” buttons at the top of
the results window.

When you do this, the program re-

calls the hits that were previously
found (excluding any which you have
manually deleted from the results win-
dow). This is a lot faster than actually
running the searches again. But, unlike
with the record of the last 20 search
terms, this history is not retained when
you close the program.

Be careful not to confuse the “Back
in search results” and “Forward in
search results” buttons with two simi-
larly-named buttons, “Previous in
search results” and “Next in search
results”, which are on the main tool-
bar. The latter pair of buttons is for
navigating within the current result set
rather than between result sets.

Also, note that the search history
has nothing to do with the document
history, which works in the same way
as in the previous version.

Favourites
A particularly useful feature in the

new program is the use of favourites.
These are what used to be called book-
marks, but they have been signifi-
cantly enhanced. It is now easier to
view and navigate them, you can ar-
range them in folders, and you can
even flag searches as favourites.

To create a favourite, bring up the
Add Favorites dialog (Figure 4). You
reach this either from the Edit menu,
by clicking on the Add To Favorites
button in the document pane, or from
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the document’s context menu (in
either pane). Once you have opened
the dialog, select the folder in which
you wish to store the favourite (or click
the appropriate button to create a new
folder), then click on OK.

Unlike in the previous version, you
do not see existing favourites in this
dialog; you simply select a folder to
store the new one in.

Once you have created some fa-
vourites, you can get at them very eas-
ily: just click on the Favorites tab in the
Contents pane. This changes the nor-
mal table of contents to a hierarchical
view of your favourites and their fold-
ers (Figure 5). You can use this to navi-
gate the favourites and select
documents for viewing. (One small
point to watch: in the Contents tab, you
single-click on a document to view it;
in the Favorites tab, you double-click.)

With the Favorites tab open, you
can re-organise your favourites by
drag and drop - dragging documents
from one folder to another, for exam-
ple. You can also annotate a favourite,
delete it or rename it. Deleting and
renaming only affect the Favorites tab;
they don’t alter the original document
in any way. When you select a re-
named document, the original name is
displayed at the foot of the pane.

As well as flagging documents as
favourites, you can save an entire
search as a favourite. Unlike with the
search history, this saves the search
specification rather than the list of hits.
This is extremely useful if you want to
periodically run the same search
against different content - after a
monthly update, for example. As well
as the search terms, this also saves the
choice of filter and other settings.

To save a search as a favourite, set
up the search in the usual way, then
click on the Favorites button in the
search window - you don’t actually
have to run the search to do this. This
will bring up the usual Add Favorites
dialog, where you select a folder to
hold the favourite.

Once you have done this, the search
will appear in the Favorites tab of the
Contents pane, alongside your other
favourites (it is usually a good idea to
rename it at this point). There is no
way of directly running the search
from the Favorites tab (maybe there

should be), but, by double-clicking on
it, you can bring up the search window
with all the settings as they were when
the favourite was created.

You can also do this by pressing the
Display button or by selecting Display
from the context menu. Either way,
just one further mouse click is all that’s
now needed to run the search.

Finally, it is possible to filter the
Favorites tab. You can choose to show
the document favourites, the search
favourites or both. You do this by
means of a drop-down list which ap-
pears at the top of the pane.

Other New Features
There is now a Send To command

on the File menu (and certain context
menus) which you can use to send
Technet documents by email. When
you select it, it brings up your usual
email client’s message-composing
window with the document already
inserted as an attachment. You can
also mail favourites in this way.

Another new command, this time
on the Edit menu, is Copy Topic. This
copies the whole of the current topic to
the clipboard with its formatting pre-
served. This is in addition to the origi-
nal Copy command, which only copies
the selected text, in RTF format and as
plain text.

An innovation which drew some
criticism from beta testers is the auto-
matic synching of the Document and
Contents panes. Although this is often
useful, it can also be a nuisance, espe-
cially if you search for a document
which is deep down in the table of
contents’ tree structure. If you sub-
sequently switch to the Contents pane,
you could be faced with a lot of scroll-
ing and clicking in order to reach other
parts of the tree. In the previous re-
lease, automatic synching was an op-
tion, but it is now permanently
enabled (at least, in the beta version).

When installing Technet, it is now
possible to copy the entire contents of
a CD to a hard disk, thus improving
performance and avoiding the need to
keep the CD loaded. In fact, this was
also possible in the previous version,
but it was not officially supported and
had to be done manually.

Finally, histories, favourites and

user-defined filters are now saved on
a per-user basis. They are saved in files
with the extension ITS, in the current
user’s directory. This means that users
who share a computer can now main-
tain their own histories, favourites and
filters, which is a welcome improve-
ment. It also makes it easier to move
these items to other machines.

Conclusion
The new Technet viewer program is

not a complete rewrite of the original.
The overall user interface is pretty
much the same, but it does offer a large
number of worthwhile improvements.
These include the simplified search
window, the ability to recall earlier
searches, the Find In Topic feature and
the enhanced use of favourites - espe-
cially the ability to view your favour-
ites in a hierarchy of folders.

Technet has always been a valuable
resource for support staff, most of
whom will welcome these improve-
ments with enthusiasm. If you have
not already done so, it is worth bring-
ing yourself up to speed with the new
viewer and learning what it can do for
you.
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Anti-Trojan Software Reviews 
A detailed review of six of the best anti trojan software programs. Two products 
were impressive with a clear gap between these and other contenders in their 
ability to detect and remove dangerous modern trojans. 
 
Inkjet Printer Cartridge Suppliers 
Everyone gets inundated by hundreds of ads for inkjet printer cartridges, all 
claiming to be the cheapest or best. But which vendor do you believe?  Our 
editors decided to put them to the test by anonymously buying printer cartridges 
and testing them in our office inkjet printers.  Many suppliers disappointed but we 
came up with several web sites that offer good quality cheap inkjet cartridges 
with impressive customer service.  
 
Windows Backup Software 
In this review we looked at 18 different backup software products for home or 
SOHO use. In the end we could only recommend six though only two were good 
enough to get our “Editor’s Choice” award 
 
The 46 Best Freeware Programs 
There are many free utilities that perform as well or better than expensive 
commercial products.  Our Editor Ian Richards picks out his selection of the very 
best freeware programs and he comes up with some real gems. 
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